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1 Visure Requirements ALM Release Notes 

1.1 Warnings 

• Commercial open database Microsoft SQL Server 2005 is no longer supported. Microsoft 

ended the extended support for SQL Server 2005 on April 12, 2016 

(https://www.microsoft.com/en/server-cloud/products/sql-server-2005/). 

• In order to comply with GDPR, throughout 2019 several applications have implemented 

additional authentication steps. Several integrations may no longer work using the user´s 

username and password and may need to request an API Token. Examples of these 

integrations include Atlassian JIRA and Azure DevOps. 

1.2 Compatibility  

WARNING 
Please review this list carefully, as there may be database changes that can affect compatibility 
between versions. 
 
The following product versions are compatible with Visure Requirements ALM 6: 
 

• Visure Requirements 5.3 & Visure Requirements 5.2 Database Schema (5.00 11): If you are 
using Visure Requirements 5.2 or 5.3, a database migration is not needed. However, previous 
versions of Visure Requirements use an older database schema, and require a migration. Once 
the database is migrated to the latest version, Visure Requirements 5.1 and older will not be 
able to access the database. 

IMPORTANT NOTE:  

Even though Visure Requirements ALM 6 is compatible with older database schemas and a 
migration is not necessary, it is highly recommended to not use older versions of the client and  
Visure Requirements ALM 6 at the same time. Visure Requirements ALM 6 implements a new 
cache mechanism which is not accessible to previous versions of Visure Requirements. 
Therefore, changes made by Visure Requirements ALM 6 will be available to older Visure 
Requirements clients, but changes made by a previous version of Visure Requirements will not 
be available to Visure Requirements ALM 6 users and inconsistent information may be 
displayed. 

• Visure Templates 5.2 and 5.3: Templates created with an older version of Visure will not be 
compatible. 

NOTE: 

In order to migrate project templates to the latest version, create a new Visure project in 
Visure Requirements 5.1/5.0 and then migrate the repository to Visure Requirements 5.2. 

• Visure Report Manager 4.8, 4.9, 4.9.1,5.0, 5.1, 5.2, 5.3, 5.4 and 6 (check Special Compatibility 
with version 6 chapter ) 

• License Server 4.9.10 (only one license file) and License Server 4.9.25. 

https://www.microsoft.com/en/server-cloud/products/sql-server-2005/)
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NOTE: Visure Requirements ALM 6 may use Visure License Server 4.9.10, but in this case, only one 
license file may be used. In order to use EXCLUSIVE and ADDITIVE licenses at the same time, Visure 
License Server 4.9.25 needs to be installed. 

• Integrations: 

o Visure Requirements integration with Atlassian JIRA 6 

o Visure Requirements integration with Azure DevOps 6 

o Visure Requirements integration with Enterprise Architect 

• Add-ins: 

o MS Word Import plugin 6 

o MS Excel Import plugin 6 

• Plugins: 

o ReqIF 6 

o Traceability Parser 6 

o Source Code Parser 6 

o Test Management 6 

o Risk Management 6 

• Deprecated compatibility: 

o VR Last Comments Plugin (this functionality is now provided out-of-the-box) 

o Help plugin 

• Currently under development 

o Visure Report Manager 6 

o Visure Requirements integration with HP ALM 6 

• Incompatible:  

o Visual Basic workflow user interfaces associated to workflow transitions (check Special 
Compatibility chapter for further information) 

o Visure Templates 5.2 and 5.3: Templates created with an older version of Visure will 
not be compatible. 

o Visure Reviewer 1.0 Comments and electronic signature 

o QVScribe 1.0.0 

o ReqIF v1, v1.0.2.501, 1.1.3.507 

o Traceability Parser 2.0.492.0 

o Source Code integration 4.8, 4.9.1, 5.1 

o Test Management (TM) v4.8, v4.9, v4.9.1 

o FMEA v4.8 

o MS Word Import plugin 1.1.0.275, 2.0.0.300, 2.0.0.302. Visure Requirements 5.4 installs 
v5.4.0.2080 automatically 

o Visure Requirements integration with HP ALM v4.8 

o Visure Requirements integration with Enterprise Architect 4.8 

o Visure Requirements integration with Atlassian JIRA v1, v2.0.0.9 
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o Visure Requirements integration with Azure DevOps v1 

 

1.3 Special Compatibility 

1.3.1 Visure Report Manager 
Visure Report Manager 5.4 and previous versions are a read-only application, and can be used in 
conjunction with Visure Requirements ALM 6. 
 
In order to make Visure Report Manager 5.4 compatible with Visure Requirements ALM 6 follow 
these steps BEFORE the installation: 

a) Make sure to maintain the ODBC connection to the database. These connections will not 
be deleted by the Visure Requirements ALM 6 installer, so they will remain after the 
installation, unless you delete them manually 

b) Make a copy of Visure Requirements 5.x folder before uninstalling and paste it in 
C:\Program Files (x86)\ . This new folder may be called VisureRequirements 5.x 

c) Open a command prompt with elevated access rights 
d) Access the C:\Program Files (x86)\VisureRequirements 5.x folder 
e) Register VRFace.dll in the new location by typing in regsvr32 VRFace.dll 
If the registration was successful, the following dialog will be displayed: 

 
f) You may now uninstall Visure Requirements 5.x and install Visure Requirements ALM 6 

 

1.3.2 Workflow scripts 
Due to the new 3-tier architecture, workflow scripts are executed in the server. This prevents 
workflows from displaying messages and any other user interface messages. Functions such as 
“MsgBox” should be disabled in the scripts. 
 

1.4 Visure Requirements ALM 6 

1.4.1 New features, enhancements and usability improvements 

1.4.1.1 Visure Authoring 
Visure Requirements ALM Platform incorporates a brand new application for users who only need 
to create items, establish traceability and collaborate with other users by reviewing specifications 
and requirements. The Visure Authoring application is a native web client that provides a very 
simple and easy to use interface. Please refer to the Visure Authoring Release Notes for further 
information. 
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1.4.1.2 Visure Reviewer 
Visure Reviewer has also been improved to take advantage of the new usability and review 
features in Visure Requirements ALM 6. 
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1.4.1.3 3-tier architecture 
The entire Visure Requirements ALM Platform has been redesigned to provide a state of the art 
infrastructure that features a 3-tier architecture. 
This new architecture uses gRPC protocol as the basis for the communication between the Visure 
Requiremens ALM client and server, providing a faster, more reliable, scalable and secure 
connection. 
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1.4.1.4 Traceability matrix 
Traceability matrices are a fundamental tool in the Requirements Engineering process. Visure 
Requirements ALM 6 provides a native support to these artifacts by allowing users to a view that 
will display end-to-end traceability, configure in a quick and simple way. For the user’s 
convenience, these matrices can be exported to MS Excel. 
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1.4.1.5 MS Excel import plugin 
The Visure MS Office plugins are an extremely efficient way of importing requirements and 
traceability in the Visure Requirements ALM platform. In addition to the existing MS Word plugin, 
Visure Requirements ALM 6 incorporates a new MS Excel plugin capable of importing complex 
tables of requirements with attributes and traceability directly from the MS Office UI. 

 

1.4.1.6 Specification baselines 
Any user may now create a baseline of their own specifications without the need of being a 
project administrator and in one single step. This specification baseline will automatically include 
all checked in items as well as all the necessary attributes and types. 
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1.4.1.7 Views 
Project administrators can now create generic views that they can share with the rest of the users 
of the project such as other project managers, engineers or testers. These users will then be able 
to apply these generic views to their own specifications, allowing them to display the information 
following pre-defined templates. 
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1.4.1.8 Additional Filters (comments and code) 
In order to provide a more collaborative environment, Visure Requirements ALM 6 provides new 
filters including code filters and comments filters. By using these new filters, Project Managers and 
other user groups can create views displaying the elements from a specification or a group of 
specifications that contain unresolved comments, and can save them in a view that can then be 
shared with other users of the project.  

 

1.4.1.9 Usability improvements: 
- Login: Visure Requirements ALM 6 provides a streamlined login process 

 
- Ribbon: The Visure Requirements ALM 6 ribbon reduces the complexity of the UI by 

including the insert options directly in the Edit tab. 
- Double click: The specifications view provides several new capabilities targeted towards 

providing users with a better user experience. Users may open the specifications by double 
clicking on them either from the navigation panel or the grid. This option is also available 
from the context menu as Open Specification and Open Specification in a New View. 
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- Context menu: The navigation panel provides a new context menu with all the 
management options, so that users can manage items directly from the navigation panel, 
including features like check-in, check-out and edit properties, among others. 

- Improved UI: The UI has been updated to provide user with a more comfortable working 
environment. 

 

1.4.2 Solved Issues 
 

• CR_00469  - Opening Specification Performance 

• CR_00466 – Open view and scroll performance 

• CR_22770 – Sort by code performance on linked items tab 

• CR_00470 – Change between views performance 

• CR_00440 – Opening project shows no items 

• CR_00468 – Visure Requirements is very slow when using VPN 

• CR_00467 – Checking out multiple items takes very long time  

Problem definition 

When the user follows  

Solution definition  

When the user follows  
 

• CR_XXX  - XXX 

Problem definition 

When the user follows  

Solution definition  

When the user follows  

1.5 Visure Requirements ALM 5.4 

1.5.1 New features, enhancements and usability improvements 

1.5.1.1 Global Parameters 
Some projects have defined sets of parameters such as conditions, ranges and other quality 
aspects e.g. max, min voltage, speed, etc., that are represented through a special type of 
requirement and referenced to from other specifications in the project. 
Apart from tracing to these parameters through traditional traceability, they sometimes need to 
be referenced to from within the description of other requirements. 
Visure Requirements ALM platform allows users to define specifications with these global 
parameters and reference them from the description of other requirements in the project. 
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The Visure Global Parameters feature allows referencing the name, description or attribute value 
of these requirements from the description of another requirement using the Global Parameter 
option inside the Hyperlink feature in the ribbon bar: 
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Once the user selects the referenced requirement and field, Visure Requiremetns ALM Platform 
will automatically convert the reference into the actual value. This value will be kept updated with 
any modification made to the original requirement 
 
 

 
 

1.5.1.2 Search in cross-references 
The cross-reference capability includes a new search capability that helps users quickly access the 
desired requirement 

 

1.5.1.3 Tab information 
Tabs at the bottom of the application now display the name of the specification 
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1.5.1.4 Following hyperlinks 
When following hyperlinks, if the destination specification is already open, the target requirement 
will be displayed in the existing window. 
 

1.5.1.5 Vertical cell separation in hierarchy view 
The hierarchy view now displays vertical lines to clearly differentiate cells, to provide users an 
environment closer to MS Excel. 
 

1.5.1.6  User information in license check out 
The license server will display user’s hostname as part of the license check out in order to facilitate 
the proper identification of the user checking out the license 

1.5.2 Solved Issues 

• CR_23110– 810,1328 -     Continuously opening "Items" tabs 

Problem definition 

When the user follows a link to a related item, if the target specification is already open in a tab, the 

application should not open a new one, and it should select the element in the already open one and put the 

focus in that tab.  

 

For instance, if a Product Requirement is related to two System Requirements SR_0001 and SR_0002. When 

clicking on SR_001 for the first time, it shall open a new tab with SR_0001 selected. When clicking on 

SR_0002, it shall not open a new tab, but select SR_002 in the System Requirements tab. 

 

Solution definition  

Now, if the linked Item is in a specification that is already opened in a tab, this tab will be enabled 
instead of opening a new tab containing the target Item. 
 

• CR_00272– 1180 -     Date and Time conversion 

Problem definition 

When working on certain time and zone areas defined on the Region option at Control Panel, some dates 

format were not correct, specially those with days 1-12 of a month 

 

Solution definition  

Now all dates format are correctly managed and displayed. 
 

• CR_00254– 872 -     Tables border in description panel 

Problem definition 

Tables created in the description panel still have a border = 0, while in the inline descriptions default borders 

are set to 1. All tables need to have a border = 1. 

Solution definition  
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All tables created on description panel or inline description have a border=1 by default. 
 

• CR_00365– 913 -     Tab names 

Problem definition 

Item tabs should display the name of the specification or data model they are displaying, instead of the 

generic element type they are displaying i.e. Items, Specifications, etc. 

If shall only display "Items", if it's not possible to display the spec name or data model. 

Solution definition  

Tabs are now displayed with the element type or specification name (for Items) 
 

• CR_00253– 1387 -     Java 7 dependencies 

Problem definition 

When installing visure requirements jre 7 is required to be installed, even if the PC already has version 8. 

Solution definition  

Jre 7 is no longer required on the install process if the system already have Jre 8 32 bits installed. 

 

 

 

1.6 Visure Requirements ALM 5.3 

1.6.1 New features, enhancements and usability improvements 

1.6.1.1 MS Word import plugin 

1.6.1.1.1 Integrated installer 
The MS Word Import Plugin is now integrated in the Visure Requirements ALM suite. The plugin 
will now be installed as a MS Word add-in automatically during the installation of Visure 
Requirements ALM. 

1.6.1.1.2 64-bit support 
The installer incorporates all Visual Studio Runtime redistributable files, which enable the use of 
the MS Word import plugin in 64-bit installations of Windows and MS Office. 

1.6.1.1.3 Round-trip improvement 
The round-trip comparison between requirements has been improved to provide a more accurate 
indication of which elements have been modified outside of Visure 
 

1.6.1.1.4 Import of multiple requirements inside tables 
The new MS Word Import plugin supports the import of requirements contained in tables. This 
process supports the import of code, name, description, attributes and traceability. 
 
These tables need to include one requirement per row.  
Example: 
 

Req ID Short Description Requirement Rationale Traceability 
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REQ_001 Calculation The system shall 
provide a 
calculation of the 
throttle based 
on… 

The calculation 
follows the 
standard 
requested by the 
customer 

TST_001 

REQ_002 Error margin The calculation of 
the throttle shall 
not deviate in 
more than… 
 

Also included in 
the same 
standard 

TST_0023 

 

 
 

1.6.1.1.5 Import of requirements with a table format 
The new MS Word Import plugin supports the import of requirements that display a table format 
in which code, name, description, attributes and traceability is in a different cell, not necessarily 
consecutive. 
In this case, only one requirement is allowed per table 
 
 
Example: 

Requirement type Requirement Requirement ID REQ_004 

Description The MS Word import plugin shall import 
requirements with a table format 

Notes Import of tables 

Requirement 
Source 

MKT_001 Relevant for 
Verificaiton 

 

Relevant for MKT X Relevant for 
Engineering 

X 
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1.6.1.1.6 Import from tags and labels 
The new MS Word Import plugin supports the import of requirements based on tags or labels. 
Each field (code, name, description, attributes and tracebility) is preceded by a tag that indicates 
the nature. To indicate the end of the requirement, another tag should be used. 
 
Example: 
REQID : REQ_0002 
Name : Label import 
Issue : 1 
Owner : F. VALERA 
Type : REQUIREMENT 
Status : INITIAL 
Release : 1.0 
Text : The system shall import requirements based on tags. 
Text of requirement 2 of EQ SPEC. 
REQ_END 
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1.6.1.2 Baseline creation and baseline comparison in Visure client 
Visure Requirements ALM Platform now incorporates the capability to create and compare 
baselines directly from the Review tab inside the client, so that users don´t need to open the 
Administration Center for these tasks. 
The baseline creation capability remains identical to 5.2 and will only be available for Project 
Administrators, whereas the baseline comparison will be available to all the users. 
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1.6.1.3 New Icon, Resolved/Unresolved comments columns 
New columns are now available for discussions and comments. The Unresolved Comments 
Indicator inside the Visual Information group displays a new icon whenever an element has 
unresolved comments, and the number of unresolved comments in the tootip. 

 
Two new columns, Unresolved Comments and Resolved Comments in the System Attributes 
group, display the actual resolved and unresolved coments in the grid, allowing users to export, 
search and filter based on the comments:  

 

1.6.1.4 Version in comments 
New comments will now include the prefix [Item Version: X], X being the version in which the 
element was created. This will allow users understand which version does the comment apply to. 
 

1.6.1.5 Upload/Download files 
Apart from associating a URL or a path, the associated files tab also allows to upload (attach) a file 
to an item. This file will be saved in the database, along with the rest of the elements, and will be 
accessible to the rest of the users regardless of their location. Users will now be able to attach a 
Visio diagram to a requirement, or evidence of a failure to an execution. 
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1.6.1.6 Paste and link 
It is relatively common to create traced elements from their origin. For instance, a first draft of a 
test plan out of the requirements, or system requirements out of detailed user requirements. The 
Paste and Link feature allows users to copy an element and paste it in a different specification 
while creating a trace automatically between the pasted item and the original item. 
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1.6.1.7 Paste as child 
The paste feature includes a new Paste as Child option to paste an item or a set of items as a child, 
or as children of the selected item. 

 
 

1.6.1.8 User filter when creating Windows Domain users 
Large organizations have hundreds or thousands of users in their domains, and searching for a 
specific user may be complicated. Visure Requirements ALM 5.3 incorporates a new user filter in 
the Advanced Settings that allows users to filter the list based on a specific username or group. 
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1.6.1.9 Close "Items" tabs more efficiently 
Different item types and specifications can be opened in different tabs so that users can quickly 
navigate between them. These tabs can be close either by the close button at the right-hand side 
of the bar, and this new version includes a new Close option in the context menu of the tab which 
makes closing the tabs more accessible. 

 
 

1.6.1.10 Inherited views 
A new view inheritance feature allows users to save a view for a given folder specification e.g. 
Specifications, Tests, so that any specification inside that folder specification will inherit the view 
from the parent folder specification e.g. User Requirements from Specifications, Acceptance Test 
from Tests, etc. 
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1.6.1.11 Non-traced items filter 
A new option in the filters dialog box allows creating filters for non-traced items either for 
outgoing and incoming links 

 
 

1.6.1.12 Edit hyperlinks 
Existing hyperlinks can now be edited by clicking on top of them: 
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1.6.1.13 Cell border default value 
New tables in Visure will automatically display a 1pt black cell border, so that when they are 
exported to MS Word, the borders are displayed. 
 

1.6.1.14 Allow adding several columns to a view at once 
The Column Chooser context menu has been converted into a persistent menu that does not 
disappear each time a new column is selecting, allowing the user to choose multiple options 
without having to display the menu each time: 

 
 

1.6.1.15 Significant performance improvement in the construction of the “Heading numbers” cache. 
Heading numbers column information has been included in the cache, providing a significant 
performance improvement for those users displaying this column. 
 

1.6.1.16 Fixed width for descriptions on Document View  
Descriptions in Visure will now display a fixed width that will not depend on the column width: 
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This improvement optimizes the use of the cache providing users a better performance when 
opening a specification consecutive times, as well as an improved experience when resizing 
columns. Additionally, users will be able to see at a glance whether a table or an image is outside 
of the margins. 
The width displayed may be configured in the project settings, Default Item Description, Page Size: 
 

 
 

1.6.1.17 Quick search Improvement 
The quick search filter is applied one second after the last character is typed in, in order to avoid a 
search before the user finishes typing in the full word or sentence 
 

 
 

1.6.2 Solved Issues 

• CR_23340 – 844 -     "Specification Panel" and "Ribbon" status on views 

Problem definition 

Specification panel and ribbon status were not saved into a view. 
 

Solution definition  

The status of the Specification panel and the ribbon will be saved in a view 
 
 

• CR_00113– 1105,1106 -     Link indicator bug 

Problem definition 
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When the cursor hovers over the ‘link indicator’ column a message appears, where all the linked items with 

link type, code and name are displayed. 

 

Unfortunately sometimes there is a crypted message displayed instead of just the item name and code 

 

 
 

This occurs when the item name contains the character "&" 

Solution definition  

The character “&” is correctly managed and the list ot linked items is now correctly displayed. 
 
 

• CR_00193 – 1193 -     Empty option in "Add or Remove Buttons" selection menu 

Problem definition 

The text filter option is not being correctly displayed on Add Remove buttons dialog: 

 

 
 

Solution definition  

The filter options are not correctly displayed: 
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• CR_00185 – 872 -     Cell border default value 

Problem definition 

The default value for cell border should be set to 1 instead than 0, also if the cell border is set to 0 the 

description should not show any table border.  This is misleading because then I would also expect that a 

border will be generated when exporting the specification to Word. 

 

Solution definition  

 
The default value for cell border is set to 1 
 

• CR_00174 – 1172 -     Error context menu to navigate to items 

Problem definition 

In the traceability tree view, when trying to navigate to related items through the right-click, the list of 

elements is incorrect. 

 

Solution definition  

 
Now, the list of related items in the context menu is the correct one. 
 

• CR_00232 –     Empty views after project creation 

Problem definition 

After project creation from template, some views do not show any item even though there are items in the 

view 

Solution definition  

 
The project template generation / restoration have been improved so that all views are correctly generated 

when creating projects based on templates. 
 

 

• CR_00203– 1219 -     Picture / Linked Picture 

Problem definition 

Inserted pictures through the option Picture/linked picture does not work correctly, the picture is shown 

while editing the description inline, but when closing the description editor the picture is not shown. When 

opening the edit mode again the picture is displayed.  

 

Solution definition  

'Link to Picture' command has been deleted from ribbon and description panel 
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• CR_00235 -    New Visure Web App users are requested license server and port  

Problem definition 

Users connecting to Visure Requirements ALM Platform through the Visure Web App for the first time are 

requested to enter the license server and port, even if these parameters are the default ones. 

 

Solution definition  

When a user connects to Visure Requirements ALM Platform for the first time and a license is not available, 

the application will look for a license server at localhost@6200, which are the default parameters. If a license 

is not available, it will then prompt the user to enter the correct parameters. 

 

• CR_00219- 1123 - MS Word Import "Compare Items" button is not clickable 

Problem definition 

On some MS Office 365 versions the button to compare items is never enabled on the word import addin. 

This happened when the Visual Studio 2013 redistributable package is not installed on the host PC. 

Solution definition  

VS 2013 component will be installed and registered so that all buttons are correctly enabled. 

 

• CR_00243- 1366 – Changes on descriptions not saved 

Problem definition 

The first time we edit the description the changes are saved, but at certain point after several editions and 

display / close of the description panel the changes made on the inline description are not being saved.  This 

is caused by an internall conflict between the inline description and the classic description panel.  

 

Solution definition  

The incompatibility between both description panels has been solved and now all changes made on 

descriptions are correctly saved. 

 

 

 

1.7 Visure Requirements ALM 5.2 

1.7.1 New features, enhancements and usability improvements 

1.7.1.1 Improved Discussions 
In order to improve collaboration between team members and avoid unnecessary emails Visure 
incorporates a new Discussion tab in which users may enter comments on requirements and other 
users may reply to them. Once the initial comment is answered, the author of the comment or 
project managers will be able to resolve the overall thread of initial comment and replies. If for 
whatever reason, the users find out that the comment was, in fact, not properly resolved, they can 
re-open the comment. 
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1.7.1.2 Cross-references 
Most authors users are used to working with MS Word and the editorial features it provides. 
Among these, cross-references are a prominent capability that allow referencing a part of the 
document from another one. Visure Requirements ALM 5.2 includes a new cross-reference 
feature that allows users reference a specific item from within a requirement´s description.  
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This reference will be converted to a native MS Word cross-reference, with the corresponding tag 
dynamic name and hyperlink when exporting the specification to MS Word. 

 
1.7.2 Solved Issues 

• CR_22570   -914, 651-     Copy and paste code 

 

Problem definition 

When pasting elements in a specification, the codes do not follow the prefix of that item 
collection. 
For instance, if we paste in Product Requirements, the new requirements should take the prefix 
PR_ 
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Solution definition  

Now when copy pasting elements, the code will follow the target specification prefix if exist. 
 
 

• CR_22560  -  643  -   Project code configuration Prefix automatically populated 

 

Problem definition 

When an Automatic Recoding is performed, the prefix is populated automatically to the Project 
Code Configuration. 
This results in duplicating the prefix, for instance PR_PR_XXXXX 
 

Solution definition  

Automatic recoding will not update the project code configuration. 
 

• CR_00117 - 1032 - Attribute value history not available in Visure Requirements 

 

Problem definition 

When changing the scope of an attribute from “Items” to some selected specifications, the 
previous versions of Items does not display the value of this attribute. 
 

Solution definition  

Past versions of Items will now show the value over attributes even if the attribute scope is 
changed. 
 

• CR_22640 - 852  - 'Invalid Port' message and Visure shuts down 

 

Problem definition 

When running Visure Requirements a message with text “invalid port” is shown, and after a few 
minutes Visure shuts down. 
 

Solution definition  

A new licensing mechanism has been implemented in Visure Requirements 5.2 

 

 

1.8 Visure Requirements ALM 5.1 
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1.8.1 New features, enhancements and usability improvements 

1.8.1.1 Project Dashboards 
Dashboards in Visure 5.1 are now part of the built-in functionality of Visure, displayed as a view in 
the product.  
Now, different projects can have separate dashboards. The path to the corresponding dashboard 
can be defined in the “Dashboard Template” project attribute. 
 

1.8.1.2 Reusability Improvement 
Reusability has been improved by simplifying the creation of new components, allowing users to 
select a set of specifications and the relationships between them. Additionally, performance and 
stability of this feature has been improved as well. 
 

1.8.1.3 New templates 
Visure 5.1 provides an improved set of project templates, including a new Aerospace Extended 
template representing the DO-178B/C Objectives. 

 
Each goal includes a reference to the corresponding section, a completion status and a set of 
references to external documents.  
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1.8.1.4 New export to MS Word 
The new export to MS Word capability allows users that do not use a name for the requirements 
to export this information closer to a standard specification. 
For the items type, Code and Description can now be exported in the same line. 
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1.8.1.5 New advanced tutorial 
Visure now includes a new Advanced Tutorial that describes some of the basic concepts in Visure 
from an administration perspective, including users, groups, partitions and permissions. This new 
tutorial also covers the basic aspects of creating a proper data model set, including specifications, 
attributes, workflows and views.  
This new Advanced Tutorial will be accessible from the Help tab in the Ribbon as online help 
(CHM), as well as in the Windows Start menu as a PDF file. 
 

1.8.1.6 New background color for table cells 
Tables can now be formatted in a similar way as MS Word, including the capability to define a 
background color for the cells in the inline description. This capability was exclusively available in 
the Description panel. 
 

1.8.2 Solved Issues 

• CR_21970 - 541,639 -    Import Tool adds empty lines in description field 

Problem definition 

When reimporting an Excel file, blank spaces were added to the description 

Solution definition  

The import process has been solved to prevent this behavior. 

• CR_23100  - 807 -   Check size of images in inline description 

Problem definition 

While working with the inline description, user must be notified that an inserted image is bigger 
than the page margins. 

Solution definition  

The inline description notifies the user when an image is outside of the margins. 
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• CR_VR_00031  - 885 -        Date Control not working properly 

Problem definition 

Having a date format defined as DD/MM/YYYY, with certain regional configuration, certain date 
formats would automatically change to MM/DD/YYYY 

Solution definition  

The date format is taken for the computer’s regional configuration 

• CR_VR_00032   - 921,940,920 -     Filters with .NET Framework 4.8 

Problem definition 

After updating .net framework to version 4.8, the filter editor doesn’t work anymore. 

Solution definition  

The filter editor has been adapted to the Windows .net framework 4.8 requirements. 

• CR_22590  - 638-      Scroll does not work on enumerated attribute columns 

Problem definition 

When displaying columns with some attributes columns, the scroll in the mouse would not work 
properly. 

Solution definition  

The events in some of the cells have been overridden, to keep the control in the mouse and 
enable scrolling. Scrolling will work on all columns except enumerated multivalued attributes ones 

• ReqIF automatically removed carry returns in certain character sets 

Problem definition 

The ReqIF import process sometimes removed carry returns in certain character sets 

Solution definition  

The ReqIF import process no longer removes carry returns. 

• CR_22910  - 748- Inline editing of the description was not saved when checking in 

Problem definition 

When editing a description through the inline editing and checking an element in without clicking 
outside of the field, the information would not be saved, requiring users to click outside of the 
field before checking in to save the description 

Solution definition  

The Check In process automatically saves the description, even if it is being edited. 

• CR_23120  - 816 - Error with Quick Insert without access rights over partition  

Problem definition 

When the user did not have access rights over the same access right as the selected element, the 
quick insert capability would not allow the user to create new items 

Solution definition  
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The Quick Insert feature validates the access rights to the different access partitions, and selects 
an appropriate access partition, or displays an error message if the user does not have access 
rights. 

• CR_23030 , CR_23040  - 763 - Plugins and Reports options disabled when opening a new view 

Problem definition 

The reports and plugins buttons in the ribbon would be disabled when opening a new view. 

Solution definition  

Opening a new view does not disable the reports or plugins features in the ribbon. 
 

• CR_23320 – 814 -  Project and Specification prefix 

Problem definition:  

When project and specification prefix are defined, the code is structured like this: 
 
Specification_ Project_ Item code 

Solutions definition 

When project and specification prefix are defined, the code will be structured like this: 
Project _Item code_ Specification 
 

1.9 Visure Requirements ALM 5.0 

1.9.1 New features, enhancements and usability improvements 

1.9.1.1 New Look & Feel  
Visure 5.0 provides a complete new look&feel, specifically designed to provide a more 
comfortable and streamlined environment for end users. This new look and feel includes general 
improvements in user interface, such as colors, font types and sizes, as well as user experience 
improvements, such as redefined navigation patterns and terminology. All these improvements 
are targeted towards providing users with an overall better experience with the tool. 
 

1.9.1.2 New Ribbon 
Visure 5.0 has a completely redefined Ribbon bar, in which the most common features have been 
grouped based on priority and goals. The Ribbon bar groups these features in different categories 
including Editor, Insert, Views, Traceability, Review, Export/Reports, Reusability and Plugins.  

 
In order to provide more working space, the Ribbon bar can be collapsed either by double clicking 
on any of the tabs, or by using the collapse button at the bottom right corner of the Ribbon. 
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1.9.1.3 New Backstage 
The Ribbon bar displays a new Project option, that takes the user to a backstage menu. This menu 
includes direct access to all the Project Organization features such as specifications, data models, 
attributes, types, workflows among others. 

 

1.9.1.4 New Element Types panel 
In order to streamline the access to the key elements in Visure, the new user interface includes a 
new Element Types Panel at the left-hand side, that provides quick access to: 

o Dashboards 
o Views 
o Specifications  
o Data Models 
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1.9.1.5 Dashboards 
The new dashboards view incorporates project specific information and metrics by means of 
widgets. Dashboards are contextual and provide different information based on where they are 
triggered from, if triggered from within a specification, all widgets will display specification-specific 
information, whereas if opened from the Specifications view, they will display overall project 
information . 

 
 

 
 

1.9.1.6 Views 
All user views are now displayed under the My Views category in the Views panel, and all shared 
views under the Shared Views category, and can be opened directly from this menu. 
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Views can now be predetermined for one specification, so that every time a specification is 
opened, it will open in a specific way e.g. Product Requirements will show requirements in a 
document format, but the Risks specification will display elements in a table format with specific 
columns. 
 
Views can also be predetermined for all specifications, except for those that already have a 
specific predetermined view for them. 

 
Views also include a new Views tab in the Ribbon that provides users a unified and streamlined 
access to the different capabilities.  
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1.9.1.7 Specifications 
Specifications (formerly Item Collections) have a dedicated view that displays the complete list of 
specifications and hierarchy between them. 

 
This view allows users to navigate to each specification by clicking on them in the browser window 
at the left. 
 
The grid displays not only the list of specifications, but also any attribute that they may take, such 
as Prefix, Document Identification, Release, or any other custom attribute. 
 
Specifications can be managed directly from this grid, allowing users to create, edit, delete, sort 
and even classify them directly from here. 
 
When navigating to a specification, the browser will automatically change to a navigation panel 
displaying the list of items in it. 
 
Users will be able to navigate back to the list of specifications by clicking on the back arrow. 
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1.9.1.8 Data Models 
The Data Models view is a completely new view that displays the list of Data Models for 
information and navigation purposes. The browser window will display the list of Data Models so 
that the users can easily select one of them. When clicking on a Data Model, Visure will display the 
list of specifications in that Data Model in the browser panel and a preview of that Data Model in 
the grid. 
 

 
 
The user will be able to navigate to any of the specifications directly from the browser panel in this 
view. 
 
This type of view allows users to focus on a specific portion of the project delimited by the Data 
Model, allowing them to reduce the complexity of the information displayed. For instance, 
software teams will be able to see only those elements relevant to their processes, but will still 
have access to other portions of the project, and hence, preventing isolation while maintaining 
simplicity. 
 

1.9.1.9 Window management 
The View tab in the Ribbon bar includes new window management features, that allows users to 
open a new window and tile it vertically or horizontally for convenient tracing of elements 
between specifications. 
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Users will also be able to right click on top of specifications in the browser panel to open them in a 
different window. 
 

 
 
Windows will be represented as tabs at the bottom of the application for easy access.  

 
 
These tabs can also be dragged in order to dock them to the sides of the user interface and place 
them side-by-side. This can also be achieved through the New Vertical and Horizontal Group. 
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1.9.1.10 Inline descriptions 
A new description inline editing capability is available, even though the former Description panel is 
still available. Users will be able to edit descriptions simply by double clicking on them. The Ribbon 
bar will display a new Description tab that will display all RTF editing features to include images, 
tables and other objects. 
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1.9.1.11 New Classification options 
The new classification toolbar 

 
Allows users to access all the different ways of classifying the items of the selected specification, 
including: 

1. Document 
2. Hierarchy (Table) 
3. Attributes 
4. Traceability Tree 
5. Access Partition 

These views can be tailored from the combo boxes displayed in the same toolbar. 
 

1.9.1.12 New Search toolbar 
The new search toolbar searches both on displayed columns and requirement descriptions. 
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1.9.1.13 New navigate between requirements 
Users will now be able to quickly navigate between items in the project by right-clicking on any of 
the columns or tabs that display traceability (Suspect Link Indicators, Link Indicators, Link Type 
columns and Linked Items tab). 

 
 
Selecting the item will automatically open the corresponding specification and select the 
corresponding item. 
 

1.9.1.14 New Add Related 
The new Add Related  

 
feature allows for the creation of new items automatically traced to the selected item, for 
instance, a new system requirement out of a product requirement, a defect from a failed test 
case, or a change request from a requirement. 
 

1.9.1.15 Plugins 
Plugins are now display in a new Plugins tab in the Ribbon panel, keeping them grouped together 
and quickly accessible: 
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1.9.1.16 Double click does not checkout 
Double clicking no longer checks out an item, and users are required to use either the context 
menu or the option in the Ribbon bar to check out items. 
 

1.9.1.17 Changes Admin Center 
The Administration center has been modified to adapt it to the new features in the Visure 5.0 
client. 
 
 

1.9.2 Solved Issues 
 

1.9.2.1 Visure Requirements Client (6) 
 
 
CR_21720        532                Hierarchy view - sort by code: In a hierarchy view sorted by code 
elements are sorted this way: 1, 1.1,1.10,1.2 … and the correct order should be: 1,1.1,1.2,1.10… 

Problem definition 

In a hierarchy view sorted by code elements are sorted this way: 

 
 

Solution definition  

Now elements in a hierarchy view sorted by code are sorted this way: 
 

 
 
• CR_21920         Toolbars selection typo - The text for global filters in the toolbar selector 

includes: in the name, it should be Global Filters 
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Problem definition 

The text for global filters in the toolbar selector includes: in the name, it should be Global Filters 
 

 

Solution definition  

This menu is no longer available in version 5 
 

 

• CR_22650        591                 Images not displayed on export to word 

Problem definition 

When exporting to word some images are not shown and the following message is displayed in 
the word document: 
 

 
 

This happens if the whole RTF description exceeds the limit of 8MB 

Solution definition  

Now there is no size limit on the export to Word 
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• CR_21980        578                  Loss of changes on elements when creating a baseline 

Problem definition 

In the following scenario the changes made on attributes values after the attribute type is checked 
in are lost: 
 
Check out attribute type 
Check out item 
Change value on the attribute 
Check in item 
Check in attribute type (or create a baseline) 
 
When back in the view, the attribute value is back to the previous value . 
 
The same can happen with Item Collections, Diagrams etc.., after creating a baseline Items IC 
allocation may get lost if elements are checked out. 

Solution definition  

Now checked out elements are correctly checked in during the baseline creation process so no 
changes are lost. 
 
• CR_22610         540                 Excel import problem. Huge fonts 

Problem definition 

Importing items from an Excel file sometimes leads to huge fonts in the description when the 
description starts with a number. 

Solution definition  

Now elements with a description that starts with a number are correctly processed and imported 
into the description field. 
 
• CR_22750 Traceability Matrix                     Descriptions in bottom rows not showing 

Problem definition 

The traceability matrix does not show the descriptions as tooltips for the bottom last 15 rows in a 
long list of elements.  

Solution definition  

Now description tooltips are displayed in the whole matrix. 
 

1.10 Visure Requirements 4.9.1 
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1.10.1 New features 

1.1.1.1 Dashboards 
The Visure dashboards plugin provides a set of predefined HTML pages, each one of them 
containing customizable widgets that display information on the project, the current specification 
or a predetermined specification. 
These widgets may display information on the progress of the project through general information 
and volatility, fulfillment of a specification through coverage diagrams, or the accomplishment of a 
test execution through Test Status Summary reports. 

1.1.1.2 Source Code integration plugin 
The new source code integration plugin allows importing a folder containing source code files in 
Visure Requirements, representing files and functions as items, in order to be able to trace them 
to low-level requirements. The parser imports over 40 programming languages, including C, C++, 
C#, Java and VHDL. 
It also includes an unattended mode that helps establish a batch process to keep the source code 
representation in Visure Requirements permanently updated with any modifications in the files. 

1.1.1.3 MS Word import plugin 
The MS Word import plugin creates a new button in MS Word that allows importing complete 
specifications in Visure Requirements. 
This new version allows re-reimport documents by comparing the contents of the MS Word 
document with the information in Visure Requirements, flagging the requirements that have been 
modified in the Word document and those that have been created new. 

1.1.1.4 Improved project templates for standard compliance 
Visure Requirements provides improved out-of-the-box project templates for standard compliance 
for Aerospace, Defense, Automotive, Medical Devices and general Systems Engineering 
environments. 

1.1.1.5 Quick insert 
Visure implements an enhanced way of creating items intended to help users in the requirements 
authoring. Visure provides two modified buttons, Add Item (INS shortcut) and Add Child Item 
(Shift + INS shortcut). When these options are selected, instead of displaying a dialog box a new 
item (or child item) will be created automatically right after the selected one. The new item will 
have the following characteristics: 

- The new item will belong to the same item collections as the selected one 

- The new item will belong to the same access partition as the selected one 

- The name of the new item will be empty, or display a dash “-” if empty names are not 

allowed. 
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- If the corresponding option is selected, the new item will inherit the same attribute values, 

except for the workflows, as the selected item. 

- If the corresponding option is selected, the new item will inherit the same incoming 

relationships as the selected item. 

- If the corresponding option is selected, the new item will inherit the same incoming 

relationships as the selected item. 

Visure provides a new Configure Quick Insert option in the Edit menu, where the user will be 
able to configure the behavior of the Quick Insert feature. 
Through the Edit menu, the user will be able to create up to 10 items in bulk. 

1.1.1.6 Add related feature 
Visure displays a new Add Related option, that will allow the user to create a new item 
automatically related to the selected item. When selecting this option, a dialog box will be 
displayed allowing the user to select the type of the new item (item collection), which will depend 
on the items that can be related to the selected one. For instance, if a Product Requirement is 
selected, only System Requirements and Acceptance tests may be created, but not Software 
Requirements. This will depend on the specific Data Models used in the project. 
Please note that the new item will only belong to the selected item collection, so the new item 
might not be displayed in the current view. 

1.1.1.7 Create database template 
The Visure Administration Center includes a new capability when right-clicking to export the 
complete database to an ipt file, that will contain all of the information in the database. 

1.1.1.8 New tutorial 
Visure now incorporates a new tutorial project that explains a more efficient and proven way of 
using Visure Requirements, aligned with the existing Visure Requirements templates. This tutorial 
features Requirements Management, Test Management, Change Management, Defect and Issue 
tracking and Risk Management. 

1.1.1.9 New triggers in plugins 
The Plugin SDK provides new triggers that can be used to launch actions when a specific action is 
performed. 

1.1.1.10 New integration framework for unattended integrations 
The new integration framework provides the skeleton for the development of an integration. This 
skeleton now provides the capability to execute the configuration based on a batch file, which 
enables a synchronization of items between tools in the background without user´s interaction. 
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1.10.2 Enhancements and Usability Improvements 

1.1.1.11 Smooth scrolling 
Visure implements a new scrolling mechanism in which the user will be able to scroll smoothly 
through the requirements in a MS Word-like way, opposed to the previous cell scrolling (MS Excel-
like). This new scrolling capability will allow users to scroll through descriptions larger than the 
actual screen height for specifications smaller than 1,000 objects. 

1.1.1.12 Description cache 
Descriptions now implement a new cache mechanism that allows a quicker representation when 
displaying larger images and OLE objects. Once the image is loaded in the cache, it will be 
displayed almost instantaneously, improving performance significantly when working with larger 
requirements. 

1.1.1.13 Relationship cache 
Relationships now implement a new cache mechanism that allows a quicker representation of the 
Link Indicators column, as well as the Link Types columns. This cache significantly improves the 
performance when displaying large amounts of links in the view. 

1.1.1.14 Status of the navigation panel 
The navigation panel will display the hierarchy collapsed by default so that users are able to find 
the desired specification and objects in an easier way. Once the application is opened, the 
navigation panel expand/collapse status will not change unless the user does so manually. 

1.1.1.15 Access to panels from context menu 
The Edit menu and the context menu now displays an option to show the Description and 
Properties panel. 

1.1.1.16 New shortcuts 
The description panel features two new shortcuts including Ctrl + S to save and Ctrl + I to apply 
italics to the selected text.  
 

1.10.3 Solved Issues 

1.1.1.17 Visure Requirements Client (8) 
 
• CR_21620      479                Increase the number of views in drop down menu 

Problem definition 

It is not possible having more than 25 views 

Solution definition  

The number of views in the drop down menu should be increased to 50 
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• CR_21670 Shared Predetermined view overwrites user`s predetermined view 

Problem definition 

The user`s predetermined view should prevail over a shared predetermined view. 

Currently, if a view is shared and established as predetermined, the user cannot change it, even if the user 
establishes another one as predetermined. 

Solution definition  

User´s predetermined view always prevails over anybody else´s view. 

 
• CR_02090 Properties tab transition and size 

Problem definition 

Properties and details tab have a lag when opening and there´s a refresh issue when they are not docked. 

Solution definition  

The properties and details tab no longer have a lag while opening. 

 
• CR_21870 Exclude elements from item collection does not work 

Problem definition 

When excluding elements from an item collection with parent item collections, it does not work. 

Solution definition  

The Exclude and Move options now behave as expected. 
 

• CR_21880 S Columns disappear when saving a view 

Problem definition 

The columns of a view disappear when saving it. When retrieving it again, the view displays no columns 

Solution definition  

Saving a view will no longer discard the existing columns 
 

• CR_21890 Last element in specification is not accessible 

Problem definition 

The last element in the specification is not accessible and cannot be reached. 

Solution definition  

The height of the specification has been fixed to be able to display the last element in the specification 
 

• CR_21360     365   Views Management - Sort by options 

Problem definition 

It should not be possible to use the sorting number as an option in the Sort by - view setting. 

Solution definition  

The sorting number is not available as an option in the Sort by - view setting. 

 
• CR_21510      89      Mouse selection impossible in dropdown listbox and then anywhere else 
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Problem definition 

The mouse seems to be unable to select items in a dropdown list box, when the list box was activated using 
the keyboard. At the same time mouse cannot be used to select anything else in Visure. The selection has to 
be finished by keyboard before the mouse can be used again.  

Solution definition  

Mouse control has been fixed on the above scenario. 

 

1.11 Visure Requirements 4.9.0 

1.11.1 New features 

1.1.1.18 Advanced export to MS Word 
The existing export to MS Word feature has been completely redesigned to allow users export 
document views in a highly customized way. The new export to MS Word feature allows users to 
select whether to automatically generate tables of contents, tables of tables and tables of images. 
It also supports the definition of different types, and the formatting of these types in the MS Word 
file. 

1.1.1.19 Captions for tables and images in description 
The description panel includes a new option inside the Insert menu that allows users to insert a 
caption above or below an image or a table in the description of an item. This allows automatically 
generate a table of tables, or a table of figures when exporting to MS Word. 
The numbering of the table or the figure will display the numbering within the item´s description, 
until they are exported to MS Word, in which case, the automatic numbering will be updated with 
the corresponding number within the document. 
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1.1.1.20 Code Prefix for items 

Item Collections now have a new system attribute called Prefix. When creating a new item inside 
an item collection that contains a text in that system attribute, Visure will append the code of the 
new item to that text, creating a predefined prefix for those item types. For instance, Product 
Requirements can take a “PR_” prefix, and system requirements “SR_”. 

1.1.1.21 Copy/Paste of items 
The copy/paste of items is now a more intuitive function that allows to create new items starting 
from a set of already existing ones in a very simple way, either within the same project, or across 
projects. 
In order to copy a set of items, the user should select the source items, select the Copy option (or 
Ctrl+C), select a target item and the Paste option (or Ctrl+V). 
When pasting the items the following information of the original set is duplicated in the newly 
created items:  

• Name and Description.   

• Hierarchy links. 

• Associated files. 

• Values of attributes (as allowed by item collection assignment). 
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• Assignment to item collections for which the “Auto-Assign” attribute is set to either “Assign 

from source”, or “Assign from target & source”. 

• The following information is acquired from the target item: 

• Position: items are pasted next to the target item. 

• Access partition: items are assigned to the access partition of the target item. 

• Assignment to item collections the target item is associated to: this will happen for the 

item collections that have the “Auto-Assign” attribute set to either “Assign from target” or 

“Assign from target & source”. 

• If destination is a document view, and the selected target item is below an item collection, 

pasted items will also be assigned to this item collection. 

Notes: 

• If there is an active item collection when pasting the items, pasted items will be assigned to 

the active item collection.  

• The item information to paste (attributes, hierarchy, etc.) is the current one when the user 

selects the Paste option. It could have been updated since the Copy option was selected. 

• Items can be pasted in the same project of the original set or in another project in the 

same Visure database; in this case, the user needs to log into the new project with the 

same credentials (login name and user role) than he/she used in the source project. 

• Links with other items are NOT copied (except hierarchical links). 

1.1.1.22 Advanced traceability restrictions 
Links between items can be limited according to the linking rules defined in data models. Visure 
Requirements extends this functionality, providing a previously available “Basics Links Restriction” 
mechanism, and introducing a new one, “Advanced Links Restriction”, which allows a tighter 
control on which links are permitted. Considering that each item in Visure Requirements can be 
associated with one or more item collections: 

• Basic Links Restriction: it will be possible to create a link between items if there is at least 

one link relating an item collection associated to the source item, and an item collection 

associated to the target item. The link between item collections shall exist in ANY data 

model selected for link restriction. 

• Advanced Links Restriction: it will only be possible to create a link between two items if the 

item collections associated to each item meet ALL restrictions explicitly drawn in the data 

models selected for link restriction. 

Let us see some examples of both types of traceability restriction: 
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• Basic link restriction: It is appropriate if only one classification criterion determines the links 

between items. For instance, we have a data model like this: 

 
If we apply the basic link restriction selecting this data model, for instance all items 
belonging to User Requirements can be linked to: 

o Any item belonging to System Requirements by the satisfied by link type. 

o Any item belonging to Acceptance Test by the validated by link type. 

• Advanced link restriction: It should be used if we need more than one classification criterion 

in order to restrict the links between items. For instance we have, additionally to the 

previous data model, this one: 

 
This means that the types of items we are going to manage are headings, requirements and 
tests. Headings are just text (titles, comments, etc.) and should not be traced to any other 
item.  
Combined with the previous data model, we mean that inside each of the item collections of 
requirements or tests (User Requirements, System Tests, etc.) we will have headings and 
proper requirements or tests. But we want to trace only these ones, not the headings. 
So, in this case we should apply the Advanced Links Restriction option selecting both data 
models to restrict the links. The addition of both models will have the effect that a heading 
can never be traced to any other item even if it also belongs to an item collection in the first 
data model (like User Requirements, System Tests, etc.). 
If we have subtypes of requirements, functional and non-functional, for all requirement 
levels (User, System and Subsystem requirements) with a restrict link type, the data model 
will look like this: 
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The first data model then has to be modified if we want to be able to create restrict links 
between requirements in the three levels: 

 

 If we want to apply the restrict link only for System Requirements, we should just eliminate 
the restrict link in this data model for the User Requirements and Subsystem Requirements. 

For both types of link restriction, in case more than one option for a link between two items is 
allowed (several link types and/or incoming or outgoing directions), the user will be able to select 
the link type and/or the direction for the link. 
To activate link restrictions, one of the options Basic links restriction or advanced links restriction 
has to be selected in the Links drop-down menu on the Settings tab of the relevant project in the 
Administration Center. 

 

1.1.1.23 Adding users for baseline signature 
A new Add User button is available in the Electronic Signature tab so that administrators can 
assign users to sign a baseline even after the baseline creation process is finished.  
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1.1.1.24 Spell checker 
A new spell checker function is now available in the Description panel of elements. The default 
language to be used can be selected by an administrator as one of the project settings in the 
Administration Center. 
Nevertheless, the following dialog is available for all users in the Tools menu in the Description 
panel:  

 

Users can enable or disable the automatic spell checker function and select the language. When a 
word is enhanced as not recognized by the spell checker, a context menu is available where 
several correct options are proposed or the word can be added to the dictionary. 

1.1.1.25 Default project templates 
A new Templates option is available for selection of templates in the project creation process. This 
step of the creation process displays a list of available project templates (ipt files) in the 
installation folder, inside a “Project Templates” folder. These templates feature support to 
different standards in multiple segments including Aerospace and Defense (DO-178B/C & DO-254), 
Automotive (ISO 26262), Medical Devices (IEC 62304 & FMEA), Railroad (CENELEC EN 50128 & 
FMEA) and Agile. 
This list can be extended with customer specific templates, supporting their own organizational 
needs. 
They can be used as a starting point to create templates tailored to the organization needs. 

1.11.2 Enhancements and Usability Improvements 

1.1.1.26 Support to Windows 10 
Visure Requirements is now fully compatible with Microsoft Windows 10 (32 and 64-bit) Operating 
System. 
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1.1.1.27 Document View formatting 
The document view has been improved to provide a smoother user experience. 

1.1.1.28 New design of Linked Items tab 
In order to improve performance and usability of the Linked Items tab, two modes are now 
available when displaying the tab: View and Edit.  
The default mode is View; the tab only displays the existing links with other items for the item 
selected in the grid. 

 
When toggling to Edit mode, the tab allows for link creation, edition and removing. 

 
The top box shows the items that belong to the item collection selected in the drop-down menu 
above the box and that are not linked to the item selected in the grid. 
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Link type and direction can be modified for already created links. 
All menus in the tab (item collection, link type and direction drop-down menus) take into account 
the link restrictions set for the project and only display available options according to these 
restrictions. 

1.1.1.29 Sorting Number for item collection 
The Sorting Number starts the numbering at the first item, instead of the item collection, 
providing a closer representation of a MS Word specification numbering. 

1.1.1.30 Removing sorting criteria 
A new option has been added to the context menu when right-clicking on the column header to 
facilitate users the possibility to remove all sorting criteria. 

1.1.1.31 Number of digits and alignment for floating attributes 
Visure Requirements allows the possibility to configure the number of decimal digits for floating 
attribute types as well as the alignment. In order to configure these options, simply right click on 
column header of the desired attribute, and select the option. 

1.1.1.32 New heading number in item views 
A new attribute called Heading Number is now available in item views. It is an attribute of items 
linked to their position in the item hierarchy; it follows the pattern n[.n], where the [.n] is 
repeated for each level in the item hierarchy starting from level 2.  
An attribute Show Heading Number for item collections is now also available. The heading number 
is only visible for those items that belong to item collections with a check in the Show Heading 
Number attribute. 
These properties of items and item collections are intended for building item views simulating the 
numbering we find in documents. We can define item collections to categorize the items 
according to the type of element they represent in a specification (titles, free text, requirements, 
test cases, etc.) and assign to them the Show Heading Number property so that only titles display 
the associated number. This way it is possible to build a document view like this: 
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1.1.1.33 Sorting of attributes in Details tab 

User attributes can now be displayed in the item Details tab in a customized sorting, not only 
alphabetically. Users allowed to modify attributes can manually arrange the list of attributes in the 
attribute view through drag & drop; this sorting can be set by each user in the Details tab using the 
context menu in the heading of the User Attributes section inside the tab. This menu has two 
options: Custom Order and Alphabetical Order. The option set by the user applies to all projects. In 
order to set up this feature, the user can simply right click on the “User Attribute” row category, 
and select the desired sorting. 

1.1.1.34 New data available in Visure Report Manager 
Suspect attribute for links and text-format description for items are now available as properties to 
be displayed in reports (properties "IsRelationshipSuspect" and "DescriptionTXT"). 

1.1.1.35 Performance improvement in SQL Server Visure databases 
When creating an SQL Server Visure database, the user is now able to select separate file groups 
for data and for indexes (same as the option already available in Oracle to use separate 
tablespaces). This way, performance in the use of SQL Server for Visure databases will be much 
improved.  
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1.1.1.36 New data available for export to HP ALM 
Requirements “Fit-criteria” is now available to be mapped with a text attribute and exported to HP 
ALM. Likewise, “Author” and “Version Author” can also be mapped with any HP ALM text attribute 
and exported from Visure Requirements to HP ALM. 

1.1.1.37 Code and Name removing in item views 
Item Code and Name are not mandatory columns anymore. They can be removed from views, just 
like any other attribute in the grid.  

1.1.1.38 Color filters saved as view settings 
Active filters in Color mode (the elements that fit the filter expression are highlighted in red) are 
now saved as part of the settings in view configuration, same as the ones in Filter mode (only the 
elements that fit the filter expression are displayed).  

1.1.1.39 Access to OLE objects in checked-in items 
Opening OLE objects from the description panel by double-clicking is now available also for 
checked-in items. It is important to note that the objective of this new feature is that users are 
able to read the documents linked as OLE objects even if the item is checked-in, but not to modify 
them. That is, since the item is checked-in, any changes made in the open document will not be 
stored in the database. 

1.1.1.40 Inline RTF description enabling 
Now the inline RTF description field is enabled in all view types, not only in the document view. 
Furthermore, a new option "Fit inline description to Name column width" is available in view 
configuration. If it is checked, the RTF description will appear right below the Name and occupying 
the same width as the Name column instead of the whole width of the grid view. 
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1.1.1.41 New default and predetermined views 
The menu option to access to the default view of any Visure Requirements element is now called 
Show all. This view displays the list of elements with Code and Name columns and with the 
Description and Properties panels docked and minimized. 
The predetermined view for items is now a document view called Specifications displaying the 
columns Item Types, Check-in/out status, Sorting Number, Code and Name. The Description and 
Properties panels are docked to the right side of the screen and minimized. 

1.1.1.42 New default options in Traceability Tree views  
In traceability tree views, the default options in drop-down menus are now the most commonly 
used: 

- Select Link Type menu: All 

- 2nd Level menu: Filter first level 

1.1.1.43 New default options in Project Settings 
Some project settings default options have been redefined in order to ensure they are the most 
commonly used:  

- Enable Links Restriction: Enabled  

Every new data model is enabled automatically. The administrator needs to uncheck it 
explicitly in case it is not intended to restrict links. 

- Allow empty names: Enabled 

- Enable changing of attribute values with Write (own) permissions: Enabled 

- Project description configuration: Enabled 

o Check description margins: Enabled 

o Check supported image formats: Enabled 

o Format: The one configured in the Windows system for all applications. 

- Automatic hierarchy when creating elements: Yes 

- Fit columns size to window size: No 

1.1.1.44 Default background color for selected items 
The default background color for selected items in the grid is now the one defined by RGB: 151-
203-255. This default option only applies if the user has not selected another one in the Color 
Configuration menu. 
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1.1.1.45 User filtering in baseline creation 
When creating a new baseline, users can be selected for baseline signature; now the list of 
available users only displays the ones assigned to the project in which the baseline is being 
created. 

1.1.1.46 User sorting in User Group Members tab 
In the Administration Center, when selecting a user group in a project, sorting is now enabled in 
the Members tab by clicking on any column heading. By default, first click over a column sorts 
values in ascending order. 

1.11.3 Solved Issues 

1.1.1.47 Visure Requirements Client (13) 
• CR_IC_16066 -  CA-2012-03-00004616 – Filter formula messed up 

Problem definition 

After adding a new value to an enumerated attribute type, if this type was used in a term of a compound filter, 

the position of this term in the filter is now the last one, so the compound filter is modified and becomes a 

different one from the intended filter. 

Solution definition  

Now the position of terms in compound filters is kept in all cases, even when an enumerated attribute type is 

modified in any way. 

 

• CR_IC_17920 - CA-2015-07-00006155 - Display issue for multivalued attributes 

Problem definition 

In the Properties tab, multivalued user defined attributes with many values assigned to an item are not correctly 

displayed; only the first 15 values are shown in the tab. 

Solution definition  

Now in the Properties tab, when an item has a multivalued attribute with more than 15 values, only the first 15 

values are shown followed by '...' meaning that there are more values assigned to the item. The full list of values 

will be displayed in the tooltip. 

 

• CR_IC_17925 - CA-2015-08-00006162 - Hyperlink malfunction with Windows Domain users 

Problem definition 

When Windows Domain is set as default validation system and Current Windows User is checked for the login 

process, if a hyperlink is generated it cannot be used later because the login window, including the OK button, 

appears greyed out, so the user is not able to open the project. 

Solution definition  

When the hyperlink is activated, if Windows Domain is set as default validation system and Current Windows User 

is checked, the username appears in the login window and the OK button is available to the user. 
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• CR_IC_17941 - CA-2015-09-00006180 – Problem in displaying TIFF-format pictures 

Problem definition 

When inserting TIFF pictures in the description of an item, the picture cannot be seen correctly in the panel. 

Solution definition  

Now TIFF-format pictures are properly displayed in the description panel. 

 

• CR_IC_17973 - CA-2015-11-00006214 - Issue in visualization of new item 

Problem definition 

When adding items in a hierarchical view using Item Template plugin the view jumps away so that the new item 

appears at the bottom of the page. 

Solution definition  

The new item appears below the previously selected one and now the view does not move or scroll. The 
bug has been fixed when adding items in a hierarchical view from Add item and Add child item buttons, 
and from the Item Template plugin.   
• CR_IC_17974 - CA-2015-11-00006214 - Issue in visualization of new items with applied filter 

Problem definition 

When adding a set of new items in a hierarchical view one after another, only the latest one is visible, the 

previously created ones disappear; when refreshing the view (with F5, for instance) all new items are visible. This 

issue happens when a filter is applied (like activating an item collection, for instance). 

Solution definition  

Now, when adding a set of items in a hierarchical view one after another, all new items are always 
visible. The bug has been fixed when creating new items from Add item and Add child item buttons, and 
from the Item Template plugin. 
 

• CR_IC_17975 -  CA-2015-11-00006214  - Issues in visualization after deleting items 

Problem definition 

In hierarchy views, after deleting items inside a hierarchical level, the selected item is the first one in the view. 

Also, after deleting a parent item, the child items are not displayed in the grid until the view is refreshed. 

Solution definition  

Now, after deleting items inside a hierarchical level, the selected one is the next or the previous item to the 

deleted ones, in the same hierarchy level. And, after deleting a parent item, the child items are visible right 

afterwards. 

 
 

• CR_IC_17976 -  CA-2015-11-00006214  - Issue in visualization of relocated item in hierarchical view 

Problem definition 

In a hierarchical view, after dragging and dropping an item in a new position in the hierarchy, the view refreshes 

and the relocated item always appears at the bottom of the screen. 
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Solution definition  

The bug has been fixed for refresh and drag & drop operations. Now the selected item remains in the same 

position in the windows; it does not jump away to the bottom of the screen. 

 

• CR_IC_18031 -  CA-2016-02-0006290  - Error in English text when assigning item collection 

Problem definition 

In the Properties panel, when modifying the assignment of item to item collections, the dialog shows some tags in 

Spanish in the English version of the tool. 

Solution definition  

The text is now correctly translated into English. 

 

• CR_IC_18046 -  Blank space in items with empty Name field 

Problem definition 

In the document view, items which do not have any content in the "Name" field are displayed with a blank space 

which depends on the height of the font selected for the name. This causes large gaps of empty spaces for most 

items. 

Solution definition  

Now in the document view, if the name of an item is empty, the style height for the name is not applied when the 

item is checked-in. The height is set to the highest cell being displayed (sorting number, columns with attributes, 

etc.) so some blank space is still visible but in most cases the gap is a small one and readability is much improved. 

 

• CR_IC_18078 -  Issue in migration of item descriptions  

Problem definition 

When migrating repositories, if there is an error in the conversion of an RTF description to HTML, the description 

is not migrated in any format. 

Solution definition  

Now when an error is detected in the migration process related to the conversion of an RTF description to HTML, 

this description is migrated only in RTF and text formats.  

 

• CR_IC_18080 -  CA-2016-04-0006331  - Poor performance when opening project 

Problem definition 

Opening a project is a very slow process in some environments. 

Solution definition  

Performance improvements have been implemented in the data loading when opening a project.  

 

• CR_IC_18088 -  Error in user validation when signing baselines  

Problem definition 
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When using Windows authentication, users cannot sign a baseline with their Windows password (an error 

message is shown). However, they are allowed to sign the baseline if the password field is left blank. 

Solution definition  

Now users have to input the correct password in order to sign a baseline for all user validation systems.  

CR_IC_20060 235 Inconsistent selection of elements 

Problem definition 

The hierarchy panel does not synchronize the selection with the grid panel when selecting elements. 

Solution definition  

Now the selection of elements in the hierarchy panel is syncronized with the grid panel 

CR_IC_20100 220 Excel export error 

Problem definition 

When exporting a filtered hierarchycal view to Excel some of the columns contents were shifted. 

Solution definition  

Now export to Excel works correctly even in filtered hierarchycal views 

CR_IC_20890 301 Change Parent 

Problem definition 

When drag and drop elements in a sorted view it was not possible to change the parent of an item. 

Solution definition  

Now elements can be moved and the change can be changed by drag and drop elements in sorted by views. In 

case of selecting “move at the same level” of an orphan item, the moved item will also become orphan, even if 

there is a sorting criterion. 

CR_IC_21280 317 Access partition on details tab 

Problem definition 

When login with user with restricted rights over the partition were items are located, the access partiion field on 

the details tab is empty. 

Solution definition  

Now the access partition is correctly displayed even if the user has no rights over it. 

CR_IC_21340 237 Format of float 

Problem definition 

The format of float attributes was not configurable, i.e. number of decimals 
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Solution definition  

Now it is possible to configure the format of float atributes 

1.1.1.48 Visure Requirements API (1) 
• CR_IC_17900 - CA-2015-07-00006144 - VR-FACE Change Comment/Description 

Problem definition 

The Change description field cannot be accessed through the API; the field is always empty. 

Solution definition  

From now on, the IVersionable "strChangeDescription" property contains the correct value of Change description data. 

 

 

2 Questions? Next steps? 
We hope you found this tutorial useful, but we understand that you may have many more 
questions. 
Please feel free to contact us at helpdesk@visuresolutions.com for technical questions, or 
info@visuresolutions.com for pricing or licensing information. 
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